
 

 
  

 

IN THE UNITED STATES DISTRICT COURT FOR THE 
SOUTHERN DISTRICT OF TEXAS 

HOUSTON DIVISION 

UMG Recordings, Inc. et al., 

Plaintiffs, 

vs. 

Janne Lanzoni, 

Defendant. 

Case No. 4:08-cv-03025 

DEFENDANT’S RESPONSES TO 
PLAINTIFFS’ FIRST SET OF 
REQUESTS FOR PRODUCTION OF 
DOCUMENTS 

 

 
GENERAL OBJECTIONS 

1. Defendant Lanzoni objects to these document requests on grounds that they 

violate Rule 26(g)(2) of the Federal Rules of Civil Procedure, given that the burden and 

expense of the document requests clearly outweigh their likely benefit, considering the 

needs of the case, the amount in controversy (ten alleged copyright songs worth an 

approximate total of $10), the parties’ resources (Plaintiffs knew that Defendant Lanzoni 

was indigent and unable to afford legal representation at the time the discovery requests 

were served), the importance of the issues at stake in the action (ten alleged copyright 

songs downloaded worth an approximate total of $10), and the importance of discovery 

in resolving the issues (Plaintiffs are well aware that this discovery is needless, because 

Defendant Lanzoni was working on February 21, 2007 when the copyrighted files were 

allegedly downloaded using an IP address allegedly assigned to her home).  Plaintiffs 

have been previously warned: 

“You know, it seems to me that counsel representing the record companies 
have an ethical obligation to fully understand that they are fighting people 
without lawyers, to fully understand that, more than just how do we serve 
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them, but just to understand that the formalities of this are basically 
bankrupting people, and its terribly critical that you stop it ...”. 

Capital Records, Inc. v. Alaujan, Case No. 03-11661-NG, Transcript of Motion Hearing, 

at 11 (June 17, 2008).  Plaintiffs served these discovery requests against Defendant 

Lanzoni at a time when she had no lawyer, and these discovery requests as a whole were 

apparently designed to bankrupt her ability to fight the baseless charges that Plaintiffs 

have made against her.  See also, Elektra Entertainment Group Inc. v. O’Brien, Case No. 

CV 06-5289 SJO (MANx), Order to Show Cause, at 2 (C.D. Cal. March 2, 2007)(“The 

concern of this Court is that in these lawsuits, potentially meritorious legal and factual 

defenses are not being litigated, and instead, the federal judiciary is being used as a 

hammer by a small group of plaintiffs to pound settlements out of unrepresented 

defendants.”). 

2. Defendant Janne Lanzoni objects to Plaintiffs’ definitions and instructions.  

“[T]he use of unreasonable ‘definitions’ may render the interrogatories so burdensome to 

the answering party and to the Court, that objections to the entire series should be 

sustained with sanctions, whether or not an occasional interrogatory might be 

reasonable.”  Diversified Products Corp. v. Sports Center Co., 42 F.R.D. 3, 4 (D. Md. 

1967)(emphasis added).  The unnecessarily complicated “definitions” used by Plaintiffs 

make the document requests unduly burdensome, because they require Defendant Janne 

Lanzoni to refer back to the definitions to determine the scope of every question, and the 

definitions result in document requests that are difficult to construe in some instances.  

Even if the document requests are considered one by one, Defendant Lanzoni would be 
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required to incorporate the applicable “definitions” in each question.  The definitions 

expand unreasonably the amount of information that is requested.  The definitions in this 

case have so expanded the information requested that many of the document requests are 

unduly burdensome. 

3. Defendant Janne Lanzoni objects to Plaintiffs’ definition of the term 

“CONCERNING.”  The term is defined as “relating to, referring to, describing, 

evidencing, or constituting.”  The use of phrases like “relating to” when applied to 

general categories of documents has been held to be objectionable.  Builders Association 

of Greater Chicago v. City of Chicago, Case No. 96 C 1122, 2001 U.S. Dist. LEXIS 

14076, at *8 n.3 (N.D. Ill. August 30, 2001), aff’d, 256 F.3d 642 (7th Cir. 2001); Schartz 

v. Unified School Dist. No. 512, Case No. Civ. A. 95-2491-EEO, 1996 U.S. Dist. LEXIS 

19123, at *3 (D. Kan. 1996); Alexander v. Federal Bureau of Investigation, 186 F.R.D. 

21, 35 (D.D.C. 1998)(The recipient “should not be required to determine the precise 

contours of plaintiffs’ requests and that is exactly what these requests would 

necessitate.”).  The Plaintiffs’ use of such broad definitions improperly shifts to 

Defendant Lanzoni the burden of determining factually and legally whether a document 

“relates” to the subject matter of the lawsuit or “evidences” something.  Builders 

Association of Greater Chicago v. City of Chicago, supra, at *27. 

4. Defendant Janne Lanzoni objects to Plaintiffs’ definition of the term 

“COMPUTER.”  Plaintiffs have defined the term “COMPUTER” to mean “all computers 

and computer components located within YOUR place of residence or otherwise within 

YOUR possession, custody, or control that had access to the Internet at any time during 
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the preceding three years through YOUR account with SERVICE PROVIDER.”  In view 

of the fact that Defendant Lanzoni’s home had a wireless router without security enabled, 

Defendant Lanzoni does not know all computers that may have accessed the Internet at 

any time during the preceding three years.  The expansion of the definition beyond 

computers located within the place of residence to include any computer under her 

“control” is indefinite because it is unclear whether the fact that Defendant Lanzoni could 

theoretically have turned off the wireless router at her home means that anyone who 

happened to access the Internet via her wireless network was “otherwise within ... [her] 

control” within the meaning of Plaintiffs’ request.  The term becomes more indefinite 

based on the definition given to the term “YOUR” by Plaintiffs.  The term “YOUR” 

includes “anyone acting under her direction.”  Given that meaning, it is unclear what 

“otherwise within YOUR possession, custody, or control” means if “YOUR” is defined 

to include “anyone acting under her direction.”  The net effect of these complicated 

multi-level definitions incorporated into each other might mean that “otherwise within 

YOUR possession, custody, or control” is limited to circumstances where she was 

somehow directing the possession, custody, or control.  The term “YOUR place of 

residence” becomes indefinite due to Plaintiffs’ definition of “YOUR.”  The definition of 

the term “YOUR” is not limited in time or place, and includes within the definition of 

“anyone acting under her direction” apparently at any time or place.  The definition given 

to the term “YOUR” by Plaintiffs would literally include employees and students who 

might be acting under Defendant Lanzoni’s direction at one time or another.  Since 

“YOUR” includes “anyone acting under her direction,” the definition of “YOUR place of 
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residence” would appear to include the residence of any employee, student, or other 

person who had ever acted under Defendant Lanzoni’s direction.  The net effect is that 

the complicated definitions provided by Plaintiffs make it difficult for Defendant Lanzoni 

to understand clearly what meaning Plaintiffs intend for these terms to have, and she 

objects to being forced to speculate concerning exactly what she is being asked.  The 

definition of “COMPUTER” is further rendered indefinite because it is defined by 

Plaintiffs to include “computer components.”  It is unclear what “computer components” 

means in this context, especially since the definition implies that it is something other 

than a computer.  For example, it is unclear whether the term “computer component” 

includes a wireless router.  It is conceivable that the answer to a particular request may be 

different depending on whether the term “COMPUTER” includes the wireless router 

within the definition of “computer component.” 

5. Defendant Janne Lanzoni objects to Plaintiffs’ discovery requests to the 

extent that the purpose of the discovery requests is to gather information for use in 

proceedings other than the pending suit.  The deadline for amending the complaint has 

passed.  Therefore, all discovery aimed at finding out information about other parties who 

might have connected to the wireless network at Defendant Lanzoni’s home could only 

be used in a different future proceeding, and would not be for use in this proceeding.  

Moreover, Defendant Lanzoni does not have the resources or the time to attempt to 

undertake an investigation on behalf of Plaintiffs concerning other third parties who are 

not known to her and/or are not parties to this lawsuit.  As the Supreme Court has said, 
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discovery is properly denied where its purpose is to obtain information for use in 

proceedings other than the present suit. 

In deciding whether a request comes within the discovery rules, a court is 
not required to blind itself to the purpose for which a party seeks 
information. Thus, when the purpose of a discovery request is to gather 
information for use in proceedings other than the pending suit, discovery 
properly is denied.  

Oppenheimer Fund, Inc. v. Sanders, 437 U.S. 340, 353 (1978)(emphasis added).  

Moreover, to the extent that Plaintiffs seek to compel non-parties to this lawsuit to 

provide their sensitive and confidential information to create data for a party’s expert 

witness, the discovery requests are objectionable.  Builders Association of Greater 

Chicago v. City of Chicago, Case No. 96 C 1122, 2001 U.S. Dist. LEXIS 14076, at *22 

(N.D. Ill. August 30, 2001), aff’d, 256 F.3d 642 (7th Cir. 2001). 

6. Defendant Janne Lanzoni objects to Plaintiffs’ discovery requests to the 

extent that they seek information as to which she has no knowledge.  Defendant Lanzoni 

can only respond to discovery requests to the extent of her own knowledge and 

information. 

7. Defendant Janne Lanzoni objects to Plaintiffs’ definition of “MADE 

AVAILABLE” and “MAKE AVAILABLE.”  Plaintiffs have previously litigated the 

issue of whether this definition is actionable, and the issue has been decided against 

Plaintiffs.  Plaintiffs are collaterally estopped from using this theory of liability.  In 

addition, it is an abuse of process for Plaintiffs to force Defendant Lanzoni to re-litigate 

an issue that Plaintiffs are collaterally estopped to pursue. 
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8. Defendant Janne Lanzoni objects to these document requests to the extent 

that they seek information protected by the attorney-client privilege, attorney work 

product doctrine, husband-wife spousal privilege, or any other applicable privilege.   

9. Defendant Janne Lanzoni objects to the instructions and definitions and the 

long list of information that Defendant Lanzoni is “required” to provide for each 

document withheld on claim of privilege as unduly burdensome for an indigent defendant 

unable to afford counsel to represent her, and beyond the requirements of the Federal 

Rules of Civil Procedure.   

10. Defendant Janne Lanzoni objects to the production of documents 

containing confidential information in the absence of a suitable protective order for the 

protection of confidential information that limits the use of such information to purposes 

of this civil action. 

The following responses to Plaintiffs document requests include each and every 

one of Defendant Lanzoni’s general objections, which shall be deemed to be incorporated 

by reference as if set forth in full in each response. 

RESPONSES TO DOCUMENT REQUESTS 

REQUEST FOR PRODUCTION NO. 1: 

All DOCUMENTS CONCERNING any registration by YOU as a user of any 

ONLINE MEDIA DISTRIBUTION SYSTEM. 
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RESPONSE:  Subject to Defendant Lanzoni’s general objections, Defendant 

Lanzoni does not have any documents evidencing her registration as a user of any 

ONLINE MEDIA DISTRIBUTION SYSTEM. 

REQUEST FOR PRODUCTION NO. 2: 

All SOUND RECORDINGS that are stored on the hard drive of the COMPUTER 

that YOU copied or downloaded using an ONLINE MEDIA DISTRIBUTION SYSTEM 

within three years before the Complaint in this action was filed. 

RESPONSE:  Subject to Defendant Lanzoni’s general objections, Defendant 

Lanzoni does not have any responsive SOUND RECORDINGS that are stored on the 

hard drive of her computer that she copied or downloaded using an ONLINE MEDIA 

DISTRIBUTION SYSTEM. 

REQUEST FOR PRODUCTION NO. 3: 

All SOUND RECORDINGS stored on the hard drive of THE COMPUTER that 

YOU ever MADE AVAILABLE via an ONLINE MEDIA DISTRIBUTION SYSTEM 

within three years before the Complaint in this action was filed. 

RESPONSE: Subject to Defendant Lanzoni’s general objections, Defendant 

Lanzoni does not have any responsive SOUND RECORDINGS that are stored on the 

hard drive of her computer that she MADE AVAILABLE via an ONLINE MEDIA 

DISTRIBUTION SYSTEM. 

REQUEST FOR PRODUCTION NO. 4: 

A complete printout of all screens depicting the contents of any folder on the 

COMPUTER that lists SOUND RECORDINGS stored in such folder, including but not 
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limited to all screens constituting a shared folder of any ONLINE MEDIA 

DISTRIBUTION SYSTEM. For purposes of this request, please do the following 

depending on the operating system of YOUR COMPUTER(S): 

Windows Users: 

A. Start up THE COMPUTER. 

B. Navigate to each folder containing SOUND RECORDINGS. 

C. Press the “Print Screen” button on YOUR keyboard. 

D. Click the “Start” button and select “Paint” from the “Accessories” menu. 

E. Select “Paste” under the edit menu in “Paint.” 

F. Under the “File” menu, select “Save” and save the file as 

“sharedfolderl.bmp.” 

G. Close the “Paint” program. 

H. If the contents of the folder do not display legibly and completely, multiple 

screenshots may be necessary to capture the full contents of the folder. Repeat steps A-G 

until the contents of the folder are accurately depicted. 

I. Repeat Steps A-G for each folder containing any SOUND RECORDINGS, 

saving these files as “sharedfolder2.bmp,” “sharedfolder3.bmp,” etc. 

J. Include all files created in this process in your response to these requests. 

MAC Users: 

A. Start up THE COMPUTER. 

B. Navigate to each folder containing SOUND RECORDINGS. 
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C. With the folder containing SOUND RECORDINGS displayed, click once 

on the desktop. 

D. While holding down the Apple and Shift keys, press 4. 

E. Put the cursor crosshair in the corner of the window containing SOUND 

RECORDINGS. 

F. Drag and hold to highlight the folder area. 

G. When you let go of the mouse button the picture file will be automatically 

created (picture1.png) and placed on the Desktop. 

H. If the contents of the folder do not display legibly and completely, multiple 

screenshots may be necessary to capture the full contents of the folder. Repeat steps A-G 

until the contents of the folder are accurately depicted. 

I. Repeat Steps A-G for each folder containing any SOUND RECORDINGS. 

J. Include all files created in this process in your response to these requests. 

RESPONSE:  Defendant Lanzoni objects to providing any documents concerning 

any iTunes folders containing sound recordings, because such sound recordings are 

irrelevant and are not likely to led to the discovery of admissible evidence.  Defendant 

Lanzoni objects to providing any documents concerning any folders containing sound 

recordings that are system alerts, notifications, and sounds relating to the operating 

system or that came with Windows or any Windows Themes, because such sound 

recordings are irrelevant and are not likely to led to the discovery of admissible evidence. 

Defendant Lanzoni objects to providing any documents concerning any folders 
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containing sound recordings unless the folders relate in some way to an ONLINE 

MEDIA DISTRIBUTION SYSTEM. 

Defendant Lanzoni objects to providing screen shots and other details concerning 

her personal information in the absence of a suitable protective order for confidential 

information limiting the use of such information to purposes of this action. 

Subject to Defendant Lanzoni’s general objections and specific objections, 

Defendant Lanzoni does not have any responsive printouts. 

REQUEST FOR PRODUCTION NO. 5: 

All DOCUMENTS CONCERNING any SOUND RECORDING that YOU copied 

or downloaded from other users of an ONLINE MEDIA DISTRIBUTION SYSTEM 

within three years before the Complaint in this action was filed. 

RESPONSE: Subject to Defendant Lanzoni’s general objections, Defendant 

Lanzoni does not have any responsive DOCUMENTS CONCERNING any SOUND 

RECORDING that she copied or downloaded from other users of an ONLINE MEDIA 

DISTRIBUTION SYSTEM. 

REQUEST FOR PRODUCTION NO. 6: 

A complete printout of YOUR screen shots depicting any publicly accessible 

folder on the COMPUTER, listing all SOUND RECORDINGS currently stored in those 

folders.  

RESPONSE:  Defendant Lanzoni objects to this request as vague and indefinite in 

its use of the term “publicly accessible folder.”  Any shared folder might be considered 

“publicly accessible” in some sense, yet have nothing to do with sound recordings. 
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Subject to Defendant Lanzoni’s general objections and specific objections, Defendant 

Lanzoni does not have any responsive screen shots depicting any publicly accessible 

folder listing SOUND RECORDINGS currently stored in such folder. 

REQUEST FOR PRODUCTION NO. 7: 

All DOCUMENTS CONCERNING any notices received by YOU from any 

Internet Service Provider CONCERNING copyrighted materials. 

RESPONSE:  Subject to Defendant Lanzoni’s general objections, any notices 

received by her from her Internet service provider mentioning copyrighted materials, that 

can be located with a reasonable search, will be produced. 

REQUEST FOR PRODUCTION NO. 8: 

All DOCUMENTS CONCERNING communications or correspondence between 

YOU and any ONLINE MEDIA DISTRIBUTION SYSTEM, including, without 

limitation, e-mail messages, messages posted on on-line bulletin boards or in chat rooms, 

and real-time internet messaging messages. 

RESPONSE:  Subject to Defendant Lanzoni’s general objections, Defendant 

Lanzoni does not have any e-mail messages, messages posted on on-line bulletin boards 

or in chat rooms, or real-time Internet messaging messages between her and any 

ONLINE MEDIA DISTRIBUTION SYSTEM. 

REQUEST FOR PRODUCTION NO. 9: 

All DOCUMENTS CONCERNING communications between YOU and anyone 

else CONCERNING any ONLINE MEDIA DISTRIBUTION SYSTEM or the “sharing,” 

“trading,” or downloading of digital music files, including, without limitation, e-mail 
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messages, messages posted at on-line bulletin boards or in chat rooms, and real-time 

internet messaging messages. 

RESPONSE:  Defendant Lanzoni objects to producing any documents dated 

subsequent to the date that this lawsuit was filed against Defendant Lanzoni, including 

attorney work product materials and investigations relating to this lawsuit. Subject to 

Defendant Lanzoni’s general objections and specific objections, Defendant Lanzoni does 

not have any responsive documents. 

REQUEST FOR PRODUCTION NO. 10: 

All DOCUMENTS CONCERNING this lawsuit or any allegations contained 

therein.  

RESPONSE:  Defendant Janne Lanzoni objects to this request as overly broad and 

unduly burdensome.  The term “CONCERNING” is defined as “relating to, referring to, 

describing, evidencing, or constituting.”  The use of phrases like “relating to” when 

applied to general categories of documents has been held to be objectionable.  Builders 

Association of Greater Chicago v. City of Chicago, Case No. 96 C 1122, 2001 U.S. Dist. 

LEXIS 14076, at *8 n.3 (N.D. Ill. August 30, 2001), aff’d, 256 F.3d 642 (7th Cir. 2001); 

Schartz v. Unified School Dist. No. 512, Case No. Civ. A. 95-2491-EEO, 1996 U.S. Dist. 

LEXIS 19123, at *3 (D. Kan. 1996); Alexander v. Federal Bureau of Investigation, 186 

F.R.D. 21, 35 (D.D.C. 1998)(The recipient “should not be required to determine the 

precise contours of plaintiffs’ requests and that is exactly what these requests would 

necessitate.”).  The Plaintiffs’ use of such broad definitions improperly shifts to 

Defendant Lanzoni the burden of determining factually and legally whether a document 
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“relates” to the subject matter of the lawsuit or “evidences” some allegation.  Builders 

Association of Greater Chicago v. City of Chicago, supra, at *27.  With all of the money 

and resources that Plaintiffs have to spend on the best legal talent available, Plaintiffs 

should be able to do a better job than this when it comes to writing document requests, 

and should not shift the burden of determining what documents fall within the scope of 

this request on an indigent defendant who cannot afford legal counsel. 

REQUEST FOR PRODUCTION NO. 11: 

All DOCUMENTS supporting any Affirmative Defense alleged in YOUR 

Answer.  

RESPONSE:  Defendant Janne Lanzoni objects to this request as overly broad and 

unduly burdensome.  “[T]he courts have long held that an interrogatory asking a party to 

identify every fact, document or witness in support of a denial or allegation of fact creates 

an unreasonable burden on the responding party.”  Larson v. Correct Craft, Inc., No. 

6:05-cv-686-Orl-31JGG, 2006 U.S. Dist. LEXIS 78028, at *14 (Oct. 25, 2006); Safeco of 

Am. v. Rawstron, 181 F.R.D. 441, 447 (C.D. Cal. 1998); Lawrence v. First Kansas Bank 

& Trust Co., 169 F.R.D. 657, 663 (D. Kan. 1996).  As aptly explained by several courts:  

To state “all” facts in support of a negative proposition, of course, includes 
an inventory of evidence which defendant itself would offer at trial to refute 
the claims of plaintiff. Beyond that, however, it would further require 
defendant to provide essentially a review of facts and commentary to 
support its evaluation, if any, that the anticipated evidence of plaintiff as to 
each disputed paragraph of the complaint simply lacks weight or 
credibility. The request for “all” facts, based not only upon knowledge, but 
also upon simply information and belief, adds a significant and reasonable 
burden to the task of the answering party. 
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Larson v. Correct Craft, Inc., supra, at *14-15; Safeco of Am. v. Rawstron, 181 F.R.D. at 

447; Lawrence v. First Kansas Bank & Trust Co., 169 F.R.D. at 663. 

REQUEST FOR PRODUCTION NO. 12: 

All DOCUMENTS CONCERNING all CDs that YOU have recorded or burned 

from any sound recording that YOU downloaded using an ONLINE MEDIA 

DISTRIBUTION SYSTEM, including without limitation the CDs themselves and all lists 

of the SOUND RECORDINGS that are included on the CDs. 

RESPONSE:  Subject to Defendant Lanzoni’s general objections, Defendant 

Lanzoni does not have any CDs that she have recorded or burned from any sound 

recording that she downloaded using an ONLINE MEDIA DISTRIBUTION SYSTEM. 

REQUEST FOR PRODUCTION NO. 13: 

An electronic copy of each of the files listed in EXHIBIT 1, attached to Plaintiffs’ 

First Set of Interrogatories, attached herewith. 

RESPONSE:  Defendant Lanzoni objects to this request as unduly burdensome.  

Since Defendant Lanzoni was not home on February 21, 2007, but was instead at work 

and could not have downloaded the files listed on Exhibit 1 at the time they were 

allegedly downloaded, it is unduly burdensome to ask her to provide an electronic copy 

of a list of 400 files that she does not have.  The Declaration of Janne Lanzoni, dated 

March 4, 2009, is incorporated herein by reference. 

Defendant Lanzoni objects to this request as unduly burdensome because it seeks 

the production of video files as to which Plaintiffs’ have no copyrights to assert, and 
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seeks the production of about 379 audio files for which Plaintiffs have no claim of 

copyright. 

Defendant Lanzoni objects to this request and the attached Exhibit 1 as offensive, 

and apparently undertaken for the purpose of causing embarrassment and/or annoyance.  

The files listed on Exhibit 1 that are included in this request include obscene and profane 

terms such as: 

“(a) asian – 3 black dudes drug and fuck two girls.wmv” 

“lesbians – charmane & miko lee – asian girls, fuck in black latex, leather & 

tattoos105.mpg” 

“asian girl fucking in bedroom.mpg” 

“college girls – mia smiles – asian filipina squeezes white dick in her pussy.mpg” 

“anna ohura – girls – big naturals – girls – angela asian big tits large nipples.mpg” 

Defendant Lanzoni objects to this request on grounds that it violates Rule 26(g)(2) 

of the Federal Rules of Civil Procedure.  Given that the burden, expense, embarrassment, 

and offensiveness of this document request clearly outweighs its likely benefit, 

considering the needs of the case, the amount in controversy (ten alleged copyright songs 

worth an approximate total of $10), the parties’ resources (Plaintiffs knew that Defendant 

Lanzoni was indigent and unable to afford legal representation at the time the discovery 

requests were served), the importance of the issues at stake in the action (ten alleged 

copyright songs downloaded worth an approximate total of $10), and the importance of 

discovery in resolving the issues (Plaintiffs are well aware that this discovery is needless, 

because Defendant Lanzoni was working on February 21, 2007 when the 400 files listed 
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on Exhibit 1 were allegedly downloaded using an IP address allegedly assigned to her 

home).  Moreover, not only are the obscene and profane files not anything that Plaintiffs 

claim as copyrighted, but the files are not even sound recordings – instead these profane 

and obscene files are all movie files.  Including them in a document request that Plaintiffs 

force Defendant Lanzoni to respond to is completely unnecessary and abusive of the 

discovery process. 

Subject to Defendant Lanzoni’s general objections and specific objections, 

Defendant Lanzoni does not have an electronic copy of the files listed in Exhibit 1 

attached to Plaintiffs’ First Set of Interrogatories. 

REQUEST FOR PRODUCTION NO. 14: 

An electronic copy of each file currently contained in any share folder accessible 

through any ONLINE MEDIA DISTRIBUTION SYSTEM. 

RESPONSE:  Subject to Defendant Lanzoni’s general objections, Defendant 

Lanzoni does not have an electronic copy of files currently contained in any share folder 

accessible through any ONLINE MEDIA DISTRIBUTION SYSTEM. 

REQUEST FOR PRODUCTION NO. 15: 

An electronic copy of the entire share folder utilized or created in connection with 

any ONLINE MEDIA DISTRIBUTION SYSTEM. 

RESPONSE:  Subject to Defendant Lanzoni’s general objections, Defendant 

Lanzoni does not have a shared folder utilized or created in connection with any 

ONLINE MEDIA DISTRIBUTION SYSTEM. 
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REQUEST FOR PRODUCTION NO. 16: 

An electronic copy of the registry files (preferences files if Macintosh) or System 

Information report (System Profiler report if Macintosh). For purposes of this request, 

please do the following depending on the operating system(s) of YOUR computer(s): 

A. For computers running Windows 95, 98, 98SE or ME, copy the files 

“system.dat” and “user.dat” located in the c: \windows directory and 

provide a copy of each file. 

B. For computers running Windows XP, 2000, 2003 or NT4 please do 

the following to create a system information report file: 

a) Click on “Start”  select “Programs” (or “All Programs”)  

“Accessories”  “System Tools”  “System Information” 

b) In the System Information window, select “Action”  “Save 

As System Information File...” 

c) In the “Save As” window, select a location to save the file 

and name it “SystemInfo.nfo” 

d) Provide a copy of the resulting “SystemInfo.nfo” file. 

C. For Macintosh computers, create a System Profiler report. 

a) From the Apple Menu, select “Apple System Profiler” 

(“System Profiler”) [alternatively, select “System Profiler” in 

the “Applications/Utilities” folder or from the Apple Menu 

click “About this Mac” and click “More Info”] 

b) With the System Profiler open, select “File”  “Save.” 
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c) If prompted for a name, name the file “SystemInformation” 

d) Provide a copy of the resulting file. 

RESPONSE:  Defendant Lanzoni objects to providing an electronic copy of the 

registry files or system information report, or any other details concerning her personal 

information, in the absence of a suitable protective order for confidential information 

limiting the use of such information to purposes of this action. 

REQUEST FOR PRODUCTION NO. 17: 

A copy of the “screenshot” of THE COMPUTER’s Windows Desktop. For 

purposes of the request, please follow these instructions: 

A. Start up THE COMPUTER and before running any program press 

the “Print Screen” button on YOUR keyboard. 

B. Click the “Start” button and select “Paint” from the “Accessories” 

menu. 

C. Select “Paste” under the “Edit” menu in “Paint”. 

D. Under the “File” menu select “Save” and save the file as 

“desktop_screenshot.bmp”. 

E. Close the “Paint” program. 

F. Click the “Start” button and press the “Print Screen” button while 

the “Start Menu” is open. 

G. Click the “Start” button and select “Paint” from the “Accessories” 

menu. 

H. Select “Paste” under the “Edit” menu in “Paint”. 
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I. Under the “File” menu select “Save” and save the file as 

“start_menu_screenshot.bmp”. 

J. Close the “Paint” program. 

K. Click the “Start” button and select “All Programs” then press the 

“Print Screen” button while the “All Programs Menu” is open. 

L. Click the “Start” button and select “Paint” from the “Accessories” 

menu. 

M. Select “Paste” under the “Edit” menu in “Paint”. 

N. Include the files “desktop_ screenshot.bmp”, 

“start_menu_screenshot.bmp” and 

“all_programs_menu_screenshot.bmp” in the backup returned to us. 

RESPONSE:  Defendant Lanzoni objects to providing copies of screenshots or 

any other details concerning her personal information, in the absence of a suitable 

protective order for confidential information limiting the use of such information to 

purposes of this action. 








